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Introduction 
 
 

 You will gain the most from this guide by first reviewing it. Also, be sure to 
back up your data. 

 
Data integration between BillQuick® (by BQE Software, Inc.) and Peachtree Accounting® (by Sage 
Software SB, Inc.) can make your time billing, accounting and financial management tasks easier. Full-
featured, BillQuick helps you manage your company, whether your time, expense, billing, project 
management and reporting needs are simple or you demand complex billing, reporting and management 
capabilities. Peachtree Accounting is a business accounting software  that provides solutions such as 
general accounting, limited time and billing, accounts receivable, accounts payable, inventory, online 
banking, job costing, reporting and payroll services. Integrated, BillQuick and Peachtree deliver a virtual 
application that ensures data accuracy, eliminates time-consuming duplicate manual entry, enhances 
flexibility, and increases control over your bottom line.  
 
The goal of the BillQuickPeachtree Integration Guide is to help users effectively integrate data 
between BillQuick and Peachtree Accounting. BillQuick controls integration, enabling you to choose 
General Ledger accounts, what data flows between the applications, and more. 
 
 

How to Use This Guide 
 
Integration means data from one application transfers to another. This sharing offers many benefits. You 
control what data transfers to and from BillQuick using synchronization settings. Your preferences tell 
BillQuick exactly how you want it to interact with Peachtree. BillQuick automatically creates smart 
connection using your settings and built-in intelligence. 
 
We encourage you to review the How Integration Works section. Written for the non-technical user, it 
explains the integration rules built into BillQuick. Understanding what type of data may be shared and the 
rules applied during synchronization, will help you visualize what is happening behind the scenes. 
 
In the Initial Integration section, you can choose the scenario which best fits your company. Instructions 
guide you through initial integration process according to your situation, whether new or existing 
BillQuick/Peachtree user.  
 
After integration, data is to be checked to make sure everything is synchronized accurately. The Quick 
Check section provides specific guidance on this aspect. The section on Day-to-Day Integration Settings 
provides suggestions for fine-tuning synchronization settings for normal, day-to-day processing.  
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Software Editions Supported 
 
BillQuick Basic (Microsoft Access), Pro (Microsoft Access and SQL Express database) and Enterprise 
(Microsoft Access, SQL Express and Microsoft SQL database) editions (2005 or later) integrate with the 
following Peachtree editions: 
 

 Peachtree Complete Accounting® (2005 or later) 
 Peachtree Accounting® 
 Peachtree Premium Accounting® ( 2005 or later) 
 Peachtree Premium Accounting for Construction/ Distribution/Manufacturing/Non-Profit (2006 

or later) 
 Peachtree Premium Accounting Accountant’s Edition (2006 or later) 
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How Integration Works 
 
 
Even if you are not a technical person, it is helpful to understand the basics of BillQuickPeachtree 
Accounting integration. This can help you visualize what is happening behind the scenes as BillQuick 
manages transfer of information to and from Peachtree. 
 
You can send BillQuick activities, expense codes, employees, vendors, clients, projects, time entries, 
invoices and payments to Peachtree. You can get activity and expense/charge items, employees, vendors, 
customers, jobs, expense and time entries, invoices and payments from Peachtree into BillQuick. You 
have to send or get the data in the order of the menu. E.g., send Clients prior to sending the Projects. 
Each record common to BillQuick and Peachtree share a unique Link ID that identifies them as related. 
This does not mean data in both records is exactly the same, only that they share common data. BillQuick 
Project records contain data and options that Peachtree Job records do not and vice versa. What is 
important for integration is that the two applications share key data.  

 

 Before integrating data, back up your data in Peachtree Accounting and 
BillQuick. 

 
The table below shows the directions in which data can potentially flow between BillQuick and 
Peachtree. Whether it flows in one direction or the other depends on your choices on the 
BillQuickPeachtree Sync Settings screen.  
 

BillQuick  
Table Name 

Dataflow Peachtree  
Table Name 

Activity Codes  Inventory Item  
(Activity) 

Expense Codes  Inventory Item  
(Charge) 

Employee  Employee 

Vendor  Vendor 

Client  Customer 

Project  Job 

Time Entry  Time Ticket 

Expense Log  Expense Ticket 

Invoice  Sales/Invoicing 

Payments  Receipts 

Chart of Accounts  Chart of Accounts 

Purchase Orders  Purchase Orders 

Vendor Bills  Vendor Bills 

 

 To review detailed, field-by-field mapping of records between Peachtree 
Accounting and BillQuick, see BillQuick Help, BillQuickPeachtree Integration, 
Table & Field Mapping. 
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As you can see above, BillQuick’s integration with Peachtree is very comprehensive. Not only are 
invoices sent to Peachtree to post revenue and receivables, the virtual database for the two applications 
includes clients, projects/jobs, employees, vendors, activity codes, etc.  
 
Bottom Line: The major benefit is that you do not have to re-enter BillQuick data into Peachtree. 
BillQuick manages the process, using your synchronization settings. 
 
 

Integration Rules 
 
To ensure accuracy and completeness of data transfer, BillQuickPeachtree integration follows a set of 
rules. These are: 
 

1. Start Date: Peachtree accepts the transfer of time, expense, invoice and payment 
records only if their dates are after the start date of the Peachtree Company. Thus, when 
you are an existing BillQuick user integrating with Peachtree for the first time, or you are 
new to both BillQuick and Peachtree and manually entering invoices, payments, and/or 
time and expenses from a prior fiscal year, be sure to check the start date of the 
Peachtree Company.  

2. Synchronization Order: When you send or get data on-demand from BillQuick or 
Peachtree (via Send, Get or Sync menu), follow the order of the sub-menus for speedier 
data transfer. For example, you should synchronize Clients before Projects and Invoices 
before Payments.  

3. PTLinkID: BillQuick automatically creates an internal PTLinkID and adds it to the 
database. Used for internal processing, the special ID ensures accurate and complete 
transfer of data. 

4. Placeholder Data: Because Peachtree does not require the same data fields as 
BillQuick and it may not track the same data as BillQuick (does not have the same fields), 
BillQuick inserts ‘FromPeachtree’ (for example) as a placeholder value when it 
encounters these situations. As part of the data checking procedure, you would change 
FromPeachtree to whatever value you desire for the field. For example, if the First and 
Last Name fields on Peachtree’s Vendor screen are blank, BillQuick inserts 
FromPeachtree into its First and Last Name fields during synchronization. 

5. Rates: When transferring employee data from Peachtree, BillQuick inserts 0$ Bill Rate 
and Pay Rate. This is because Peachtree supports only hourly billing with optional Bill 
Rate and no Cost Rate. 

6. Client Contacts: Client contacts in BillQuick transfer to Peachtree automatically when 
you synchronize clients. 

7. Project: BillQuick handles the integration of project phases with Peachtree. 
8. Time Entry:  

 After transferring a time record from BillQuick to Peachtree, it can only be 
transferred again as a new entry or record. 

 Negative time entries cannot be transferred from BillQuick to Peachtree. 
9. Purchase Orders and Vendor Bills: Purchase orders and vendor bills are integrated between 

BillQuick and Peachtree. The received items information is also transferred against the 
appropriate purchase order, adjusting the vendor bill accordingly.  
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10. Peachtree Invoice: When transferring invoices from Peachtree to BillQuick, several 
scenarios can arise.  

 Client Invoice but No Job Record: When BillQuick encounters an invoice from 
Peachtree that is associated with a client rather than a job/project, it 
automatically creates a project record and uses the Client ID to create the 
Project ID. This is done because BillQuick requires projects, and invoices are 
associated with projects (scopes or types of work) done for clients. 

 Invoice for One Job, different Client: When BillQuick encounters an invoice from 
Peachtree that contains items for a single project with a client other than the 
invoice client; it associates the invoice with the specific client of the project. 

 Invoices for Multiple Jobs, Same Client: When BillQuick encounters an invoice from 
Peachtree with items for different jobs but the same client, it creates a ‘joint 
invoice’. In other words, the invoice items for each job are associated with the 
corresponding project in BillQuick. Together, they are reported in BillQuick as a 
Joint Invoice. 

 Invoices for Multiple Jobs, Different Clients: When BillQuick encounters an invoice 
from Peachtree with items for different jobs and those jobs involve more than 
one client, BillQuick will not transfer the invoice. You must revise the invoice in 
Peachtree so it only reflects items for jobs associated with a single client, and 
then synchronize with BillQuick again. 

11. BillQuick Invoice:  
 When BillQuick sends an invoice with taxes to Peachtree, there are two items 

(Service Amount and Service Tax Amount) appearing as a single line item. 
Hence, different accounts cannot be specified for them.  

 Joint Invoices are integrated between BillQuick and Peachtree. 
12. Payment: Like invoices, when transferring payments to/from BillQuick, several scenarios 

can arise. 
 Payment to Client Invoice, No Job: When BillQuick encounters a payment from 

Peachtree for a client invoice rather than a job/project invoice, it automatically 
creates a project record (if it does not exist) and uses the Client ID to create the 
Project ID. This is done because BillQuick requires projects, and invoices are 
associated with projects (scopes or types of work) done for clients. 

 From Peachtree Payments, No Invoice in BillQuick: When BillQuick encounters a 
payment from Peachtree for which the associated invoice does not exist in 
BillQuick, it will transfer the payment into BillQuick. The payment is ‘on-account’ 
for the client and can be used to pay invoices and/or reduce the net bill amount 
of future invoices. 

 No Invoice: A payment entered in BillQuick/Peachtree transfers to 
Peachtree/BillQuick even if the associated invoice does not exist in the other 
application. 
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Peachtree Accounts 
 
A general ledger contains financial transactions and balances in various accounts for the specified fiscal 
year or time period. It represents a complete collection of accounts (chart of accounts) of a company, 
transactions associated with these accounts, and account balances for a specified period of time. 
 
For companies that integrate BillQuick with Peachtree, they need to specify default General Ledger 
accounts for the services, expenses, invoice and other items in BillQuick (prior to the sync). Normally, 
the transactions debit or credit these accounts. 
 
The G/L account that you select depends on whether your company follows a Cash Basis or Accrual Basis 
of accounting. For cash basis, the Income Account is where payments from BillQuick are posted. The 
Sales Account receives invoiced activities or services; and the Inventory Account receives invoiced 
expenses. BillQuick posts costs (time, expenses) associated with an invoice to the Cost of Sales Account. 
For accrual basis, the same accounts are used except that the Income Account is not needed. 
 
In BillQuick, activity and expense accounts are not required, except for the purpose of data integration 
with Peachtree. For all activity and expense codes in BillQuick, you can specify different G/L accounts. As 
activities, expenses and other items are part of an invoice, when you synchronize invoices with 
Peachtree, BillQuick assigns the specified G/L accounts to each item. Accordingly, the correct G/L 
accounts are updated in Peachtree after sync. This tracks your company’s income and expenses in the 
accounting system. 
 
 

Accounts Assignment 

 
Accounts for various BillQuick items can be set up in two ways: 
 

 Integration menu: You can assign accounts to BillQuick activities and expenses, and other items 
via the BillQuick-Peachtree Sync Settings-Accounts screen. Peachtree accounts are available for 
assignment after a connection between BillQuick and Peachtree is established.  

 
 Peachtree: If you integrate with Peachtree and GET Service and Expense Items, the associated 

G/L accounts also transfer to BillQuick.  
 
To assign accounts to BillQuick items: 
 

1. Open the BillQuick-Peachtree Sync Settings screen from the Integration menu, Peachtree 
Accounting.  

 
2. Select the Accounts tab. Choose Default Accounts on the left. 

 
3. Select the Peachtree accounts for the Default option. You can also specify some of these 

accounts at the project level by selecting the Project or Project Group option. Project accounts 
will override the ones specified at the Default level. 
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4. Assign the following Default Accounts from the dropdown lists to expenses and activities sent to 
Peachtree. 
 
G/L Income Account: Income account contains revenue items (from the sale of products and 
services to the customers). For your business, you may need to create specific income accounts, 
based upon items and services you offer. Different income accounts are created for each 
category of revenue that is being tracked (e.g. retail income, service income, interest income, 
etc). Hence, for activity and expense codes transferred from BillQuick to Peachtree, specify the 
corresponding G/L account. 
  
G/L Sales Account: Sales Account contains information about all incomes resulting from the 
sales for the specified fiscal year. Sales represent the sum of all incomes for a company. 
Peachtree requires each customer to have a default sales account (typically an income account), 
to be used when recording a sale. Different sales accounts are created for each category of 
income that is being tracked (e.g. services, inventory, etc). Selection of this account is optional 
for BillQuick users. 
  
G/L Inventory Account: Inventory Account contains information about inventory items that 
you want to track (e.g. retail, raw materials, work in progress, finished goods inventory, etc) for 
the specified fiscal year or time period. Inventory represents the quantity or value of goods on 
hand and available for sale at any given time. It is considered to be an asset that is purchased, 
manufactured, and sold to customers for revenue. Selection of this account is optional for 
BillQuick users. 
  
G/L Cost of Sales Account: Cost of Sales Account contains information about the known cost 
to your business for items or services when sold to customers for the specified fiscal year. This 
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account type is used if you are setting up cost-of-goods-sold accounts when selling inventory 
items. Cost of sales for inventory items is based on inventory costing method. Different accounts 
are created for each category of cost that is being tracked (e.g. freight expense, shipping charges, 
inventory costs, etc). Selection of this account is optional for BillQuick users. 
 

5. Now, specify the following Default Accounts for invoices sent to Peachtree. These are the 
default accounts where the line item amounts on BillQuick invoices transfer after sync with 
Peachtree.  
 
A/R Account: Accounts Receivable represents amounts owed by customers for items or 
services sold to them. Typically, A/R balances are recorded on sales invoices that include terms of 
payment. If you have set up your company on an accrual basis, you must enter an A/R general 
ledger account. Different A/R accounts are created for each category of accrued income that 
customers owe. Hence, for invoices transferred from BillQuick, you have to specify the 
corresponding account.  
  
G/L Account: General Ledger contains information about all the financial transactions and 
balances in various accounts for the specified fiscal year or time period. Different G/L accounts 
are created for invoice items that are being tracked. You can specify a G/L account for the paid 
invoices. 
 

6. Next, select the Cash Account for payments sent to Peachtree. 
  
Cash Account contains information about all the cash transactions and balances for the specified 
fiscal year or time period. Cash represents available deposits in banks, cash on hand, un-
deposited checks, drafts, money orders, etc. Different cash accounts are created for each 
category, such as bank checking accounts, petty cash accounts, money market accounts, 
certificates of deposit (CDs), payroll, cash receipts, cash sales, etc. Hence, for payments 
transferred from BillQuick to Peachtree, you have to specify the corresponding account. 
 

7. Finally, specify the following Default Accounts for vendor bills and purchase orders sent to 
Peachtree. 
 
A/P Account: Accounts Payable is an account that contains money that the company owes to its 
vendors. It represents credit that the vendor offers to the company by allowing it to pay for a 
product or service at a later time. You can specify an A/P account for the Purchase Orders. 
  
Sales Account: Sales account can be assigned to the Vendor Bills. 
 

8. If you want to assign separate accounts to individual activity items, select Activity Accounts option 
on the left. Assign the desired A/R Account and G/L Account per item. These accounts override the 
default accounts specified earlier. 
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Similarly, you can specify individual accounts per expense item from the Expense Accounts panel.  

 
9. When done, click Save and then Close to exit.  
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Initial Integration 
 
 
Preferences controlling how BillQuick and Peachtree work together are managed through the Sync 
Settings screen. It is accessed from the Integration menu, Peachtree Accounting. During integration setup 
and synchronization procedures, both BillQuick and Peachtree must be running. Peachtree allows only 
on-demand synchronization.  
 
 

Security Permissions 
 
Before you ask BillQuick to synchronize data with Peachtree, you (the user) must have security 
permission in BillQuick to perform the task. The BillQuick Supervisor in your company assigns security 
permissions to users. 
 
Second, you must tell Peachtree to allow direct communication with BillQuick. To do this, again you 
must have the security permissions. Once you do, you would set the security level for BillQuick (called a 
Peachtree Partner) on Peachtree’s Maintain Global Options screen.  
 

 
 
With Medium security, for example, each time you synchronize data, Peachtree prompts you to allow 
BillQuick to access your Peachtree database (one currently open in Peachtree). Other options provide 
more or less open security access. 
 
 

Scenario 1: Existing BillQuick-New Peachtree 
User 
 
BillQuick users who are new to Peachtree Accounting start by transferring information from BillQuick to 
a new Peachtree database. After creating the Peachtree file and setting synchronization preferences, you 
can initiate synchronization and check the transferred data.  
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Please follow the steps below to integrate BillQuick and Peachtree. 
 
1.  Peachtree Database 
 
Before integrating with BillQuick, a new Peachtree user must first create a Peachtree database and assign 
the Peachtree Partner security level (see Security Permissions above or Peachtree Help for more). 
 

1. When Peachtree opens, choose ‘Create a New Company’. The New Company wizard launches. 
Click Next. 
 

 
 

2. Enter company name, address and other details. 
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3. Select your business type and if you wish, let Peachtree suggest a Chart of Accounts for your 
business type. If you already have a chart of accounts, enter them after exiting the wizard. 

 
4. Enter your preferred accounting method, period and other financial data. 
 
5. Enter the required information and exit the wizard. 

 
6. Use the Peachtree Setup Guide to customize company defaults and create company records.  

 

 
 
2.  Backup Database 
 
For the first-time sync, it is important to back up your BillQuick database. Select BackUp Database from 
the Utilities menu. By default, BillQuick stores the backup copy in the same folder as the company 
database (for example, the standard installation folder x:\Program Files\BillQuick2011; x = drive letter). If 
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you want the database copy to be saved in another location, select Global Settings-Folders from the 
Settings menu and enter a new location.  
 
3.  Sync Settings 
 
For BillQuick to know what data to transfer and other integration preferences, you need to define 
integration settings. Later, you can fine-tune the settings for day-to-day integration (see 5. Fine-Tune 
Synchronization Settings below).  
 

1. In BillQuick, look at the status line at the bottom. It displays the BillQuick database that is open. If 
it is not the one you want to integrate with, select File menu, Open Company. Choose the correct 
company, and then continue to the next step. 

 
2. From the Integration menu, select 

Peachtree Accounting, Sync Settings. 

 
 
 
 
 
 
 
 

3. Click the General tab. Select your Peachtree Version. Also, select the desired Peachtree 
Company file from the drop-down list or click Browse to locate it. 
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4. Click the Connect button to establish a link to the Peachtree database. If the Peachtree 
application is not running, it starts automatically.  

 
You can see the location of the BillQuick Database that will integrate with Peachtree. 

 
5. If you want to map the Peachtree Cost Codes to BillQuick Activity/Expense Codes during sync, 

check that option at the bottom. 
 
6. Click the Send Settings tab. In order, select each Module and assign desired settings to it.  

 

 
 

7. You need to decide whether to send each type of BillQuick data to Peachtree. If you wish to 
restrict what data records transfer to Peachtree, choose one or more filters. See BillQuick 2011 
Help for more information. 

 

 The Get Settings tab is not used because we are sending data from 
BillQuick to populate a new Peachtree database. 

 
8. Click the Accounts tab.  

 
In Peachtree, each item is associated with a general ledger (G/L) account. To ensure activities, 
expenses, invoices and other BillQuick items update the correct G/L account in Peachtree, 
specify their default accounts from the dropdown list. See Peachtree Accounts for more. 
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9. Every payroll item in BillQuick must be assigned a number that will determine the order in which 
it will be listed in Peachtree’s Pay Types list. Select a number for the Default Payroll Item. 
 

10. If you want to specify the payroll settings for a specific Employee or Employee Group, select that 
option. Then select a number for different payroll items, say 1 for Regular Time, 2 for Overtime, 
5 for Vacation, etc. This will override the default setting specified above. 
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 If you assign payroll settings to the Employee Group ‘ALL’, you no longer 
have to go back to Sync Settings screen every time you add a new employee in 
BillQuick. 

 
11. Click Add to associate these BillQuick payroll items to the Peachtree Pay Types and then click 

Save. 
 
4.  Send Data 
 
Now you are ready to synchronize data with Peachtree. 
 

1. From the Integration menu in BillQuick, select Peachtree Accounting, Send to Peachtree.  
 

 
 
2. In turn, select each menu item, starting with Activity. After the progress bar indicates that the 

transfer is complete, open the corresponding screens in BillQuick and Peachtree and verify the 
data is complete. See Quick-Check for more information. 
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Repeat this step for the next menu item. Below are the BillQuick Send menu items and the 
corresponding Peachtree screen. 
 

BillQuick  
Send Menu Item 

Peachtree  
Screen 

Activity* Inventory Item 
(Activity) 

Expense Item* Inventory Item 
(Charge) 

Employees* Employee 

Vendors* Vendor 

Clients* Customer 

Projects* Jobs 

Time Entry Time Ticket 

Expense Log Expense Ticket 

Invoices Invoice 

Payments Receipts 

Chart of Accounts Chart of Accounts 

Purchase Orders Purchase Orders 

Vendor Bills Vendor Bills 

* The screen name may be different based on your profession or industry, or if you customized 
them using BillQuick’s Custom Label feature. 

 
5.  Fine-Tune Synchronization Settings 
 
After you check the data transferred to Peachtree, you may wish to change your integration settings to 
ones better suited for day-to-day synchronization. See Day-to-Day Integration Settings for more 
information. 
 
 

Scenario 2: New BillQuick-Existing Peachtree 
User 
 
Peachtree users who are new to BillQuick start by transferring information from Peachtree to a new 
BillQuick database. After creating the BillQuick Company and setting synchronization preferences, you 
can initiate synchronization and check the transferred data.  
 
Please follow the steps below to integrate BillQuick and Peachtree. 
 
1.  BillQuick Company 
 
Before integrating, a new BillQuick user must first create a BillQuick company database. BillQuick 
requires security permission to perform this task (see Security Permissions above). 
 



Initial Integration 

 

BillQuickPeachtree Integration Guide 2011.1                                                                                                                     Page 18 

1. In BillQuick, select File menu, New Company. Choose the type of database technology you wish 
to use. If unsure, choose Standard.  
 

 The database technology available to you depends on the BillQuick edition 
purchased. If you are unsure what edition you licensed, select About BillQuick 
from the Help menu. The edition abbreviation displays right after the version 
number. 

 

Edition Database Technology 

BillQuick Basic Microsoft Access (Standard) 

BillQuick Pro Microsoft Access 
Microsoft SQL Express 

BillQuick Enterprise Microsoft Access 
Microsoft SQL Express 
Microsoft SQL Server 

 
2. On the New BillQuick Database dialog, enter a name for the new database. Most commonly, the 

company name is used for easy identification. Click the Open button. BillQuick creates the 
database and opens the BillQuick Startup Interview wizard.  

 

 The BillQuick Start-Up Interview can be closed and reopened later. To do 
so, select Wizards, BillQuick Interview from the View menu. 

 
3. On the BillQuick Start-Up Interview panel, click the Next button.  
 
4. Leave Business Type blank. If you select a type, BillQuick copies industry-specific activity 

(service) and expense codes into your firm database. These codes are not needed because items 
will transfer from Peachtree into BillQuick. Click the Next button.  

 
5. Custom Labels allow you to customize key business terms to your profession and firm-preferred 

terminology in BillQuick. Customizing terms eases transition from your old time and billing 
solution. Select your preferred terms from the drop-down lists. When done, click the Next 
button. 

 
6. On the Company Name panel, enter your company name. Spell it exactly as it appears on your 

License and Registration (or Evaluation) Key email.  
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7. Click the Next button to accept the defaults on the remainder of the panels. You can update 

these options later on the Global Settings and Preferences screen. On the last panel, click the 
Finish button. 

 
8. The BillQuick Initial Setup Checklist wizard displays. This wizard enables the first time user to 

create master information; setting up basic employee, client, project, etc, confirming the actions 
using the checklists. When done, click the Close button. 
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9. The Company screen displays. Either complete the fields now and click the Save button when 
done; or click the Close button and perform this task later.  
 

10. From the File menu, select 
Login. For User ID, type 
‘supervisor’ (without quotes), 
then for password, type 
‘supervisor’ (without quotes). 
This gives you full security 
permissions in BillQuick to 
perform integration tasks.  

 
 
 
 
2.  Backup Database 
 
For the first-time sync, it is important to back up your Peachtree database. Select Back Up from the File 
menu. Click on the Back Up button on the dialog to make a copy of your database. 
 
3.  Sync Settings 
 
For BillQuick to know what data to transfer and your other integration preferences, you need to define 
sync settings. Later, you can fine-tune these settings for day-to-day integration (see 5. Fine-Tune 
Synchronization Settings below).  
 

1. Look at the status line at the bottom of the BillQuick screen. It displays the currently open 
BillQuick database. If it is not the one you want to integrate with, select File menu, Open 
Company. Choose the correct company, and then continue to the next step. 

 
2. From the Integration menu, 

select Peachtree Accounting, 
Sync Settings.  
 
 
 

 
 

 
 
 

 
 

3. Click the General tab. Select your Peachtree Version and the desired Peachtree Company file 
from the drop-down list or click Browse to locate it. 
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4. Click the Connect button to establish a link to the Peachtree database. If the Peachtree 

application is not running, it starts automatically. At the bottom, it displays the location of the 
BillQuick Database that will integrate with the Peachtree data. 

 
5. Click the Get Settings tab. In order, select each Module and assign desired settings to it. 
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6. In most cases, you only need to decide whether to get each type of Peachtree data. If you wish 
to restrict what data records transfer from Peachtree, choose one or more filters. See BillQuick 
2011 Help for more information. 
 

4.  Get Data 
 
Now you are ready to transfer data from Peachtree to BillQuick.   
 

1. From the Integration menu in BillQuick, select Peachtree Accounting, Get from Peachtree.  
 

 
 

2. In turn, select each menu item, starting with Service Items. After the progress bar indicates that 
the transfer is complete, open the corresponding screens in BillQuick and Peachtree and verify 
the data is complete. See Quick-Check section for more information. 

 

 Bill Rate and Cost Rate in employee records must be updated before 
synchronizing time records. Special bill rates/cost rates associated with work 
done by employees on a project must be defined in a Service Fee Schedule and 
assigned to the project before synchronizing time records.  
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Repeat this step for the next menu item. Below are the BillQuick Get menu items and the 
corresponding Peachtree screen. 
 

BillQuick  
Get Menu Item 

Peachtree  
Screen 

Service Items* Inventory Item 
(Activity) 

Charge Items* Inventory Item 
(Charge) 

Employees* Employee 

Vendors* Vendor 

Clients* Customer 

Jobs* Jobs 

Time Entry Time Ticket 

Expense Log Expense Ticket 

Invoices Invoice 

Payments Receipts 

Chart of Accounts Chart of Accounts 

Purchase Orders Purchase Orders 

Vendor Bills Vendor Bills 

* The screen name may be different based on your profession or industry, or if you customized 
them using BillQuick’s Custom Label feature. 

 
5.  Fine-Tune Synchronization Settings 
 
Data touchup is needed in BillQuick after getting data from Peachtree because BillQuick requires certain 
fields which might be optional in Peachtree. 
 
After you check the data transferred to BillQuick, you may wish to change your integration settings to 
ones better suited to day-to-day synchronization. See Day-to-Day Integration Settings for more information. 
 
 

Scenario 3: New BillQuick-New Peachtree 
User 
 
If you are new to both BillQuick and Peachtree Accounting, you need to set up company databases in 
both applications, enter and/or import master information in BillQuick (or Peachtree), then synchronize 
the data with the other application.  
 
To gain the most complete and useful practice management information from the start and reduce setup 
time, we recommend that you add or import all master information and other time and billing data into 
your BillQuick firm database, then synchronize it with Peachtree. 
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 BillQuick’s Import/Export function (Utilities menu) reads data in Comma 
Separated Value (comma delimited) or Tab Delimited files. In this utility, you 
can associate each data field with the corresponding one in BillQuick. If your old 
application exports data to a comma - or tab - delimited file format, or to 
Microsoft Excel (which can save data in these file formats), you can reduce 
setup time.  

 
1. BillQuick Company Database 
 
Before integrating, a new BillQuick user must first create a new BillQuick company database. BillQuick 
requires security permission to perform this task (see Security Permissions above). 
 

1. In BillQuick, select File menu, New Company. Choose the type of database technology you wish 
to use. If unsure, choose Standard.  

 

 The database technology available to you depends on the BillQuick Edition 
purchased. If you are unsure what edition you licensed, select About BillQuick 
from the Help menu. The edition abbreviation displays right after the version 
number. 

 

Edition Database Technology 

BillQuick Basic Microsoft Access (Standard) 

BillQuick Pro Microsoft Access 
Microsoft SQL Express 

BillQuick Enterprise Microsoft Access 
Microsoft SQL Express 
Microsoft SQL Server 

 
2. On the New BillQuick Database dialog, enter a name for the new database. Most commonly, the 

company name is used for easy identification. Click the Open button. BillQuick creates the 
database and opens the BillQuick Startup Interview wizard. 

 

 The BillQuick Start-Up Interview can be closed and reopened later. To do 
so, select Wizards, BillQuick Interview from the View menu. 

 
3. On the BillQuick Start-Up Interview panel, click the Next button.  
 
4. For the Business Type, you would select a type if you want BillQuick to copy default industry-

specific activity (service) and expense codes into your firm database. If you wish to use your own 
set of codes, leave the field blank and click the Next button.  

 
5. Labels allow you to customize key business terms to your profession and firm-preferred 

terminology in BillQuick. Customizing terms eases transition from your old time and billing 
solution. If you selected a business type on the previous panel, common terms or custom labels 
display for your profession. If you left business type blank, these fields will be blank too. To select 
a BillQuick label, click the drop-down. When done, click the Next button.  
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6. On the Company Name panel, enter your company name. Spell it exactly as it appears on your 
License and Registration (or Evaluation) Key or email.  

 

 
 
7. Click the Next button to accept the defaults on the remainder of the panels. You can update 

these options later on the Global Settings and Preferences screen. On the last panel, click the 
Finish button. 

 
8. The BillQuick Initial Setup Checklist wizard displays. This wizard enables the first time user to 

create master information; setting up basic employee, client, project, etc, confirming the actions 
using the checklists. When done, click the Close button.  
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9. The Company screen displays. Either enter data now and click the Save button when done, or 
click the Close button and perform this task later.  
 

10. From the File menu, select 
Login. For User ID, type 
‘supervisor’ (without quotes), 
then for password, type 
‘supervisor’ (without quotes). 
This gives you full security 
permissions in BillQuick to 
perform integration tasks.  
 
 

 
 

2.  Peachtree Database 
 
A new Peachtree user must first create a Peachtree database and assign the Peachtree Partner security 
level (see Security Permissions above). 
 

1. When Peachtree opens, choose ‘Create a new company’. The New Company Setup wizard 
launches. 

 

 
 
2. Enter company name, address and other details. 

 
3. Select your business type and if you wish, let Peachtree suggest a Chart of Accounts for your 

business type. If you already have a chart of accounts, enter them after exiting the wizard. 
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4. Enter your preferred accounting method, period and other financial data. 
 
5. Enter the relevant information and exit from the wizard. 

 
6. Use the Setup Guide to customize company defaults and create company records.  
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3.  Set up Data 
 
Setting up data may be a manual process, utilize imported data, or a combination of both. The sequence 
for efficient setup is: 
 

BillQuick  
Setup Sequence 

BillQuick 
Screen 

Employees Employee* 

Clients Client* 

Activity Items Activity Codes* 

Expense Items Expense Codes* 

Vendors Vendor* 

Projects Project* 

Time Entries Time Entry* 
(Sheet View) 

Expense Entries Expense Log 

Invoices Invoice Review 

Payments Payment 

Chart of Accounts Chart of Accounts 

* The screen name may be different based on your profession or industry, or if you customized 
them using BillQuick’s Custom Label feature. 

 
1. Master information should be set up or imported first. In BillQuick, this data includes (View 

menu) Employee, Clients, Activity Codes, and Expense Codes. If you have subcontractors or 
consultants for whom you record time or expenses, also set up Vendors. Other types of master 
information can be added later.  

 
When setting up new records, you only need to enter data into a few required fields. All required 
fields have BLUE field labels. Other data can be entered now or later. 
 

2. The term ‘project’ may be changed in BillQuick to Engagement, Matter, Job, Work Order or any 
other term you prefer. Phases and segments are sub-projects or detailed breakdowns of work 
being done for a client. 

 
Projects represent the scope of work or type of service performed for a client. Each project 
record contains contract, billing arrangement, budget, special billing rate, and other elements that 
control how BillQuick adapts to your firm and processes data. When billing, BillQuick 
automatically organizes information by project (with the option to create one invoice per project 
or one invoice for all of a client’s projects), making it easier and faster to bill clients. Also, practice 
management information is more detailed and readily available by project.  
 
An accountant, for instance, may deliver tax, write-up, payroll and consulting services to a client, 
each billed differently (fixed fee, recurring monthly fee, hourly), and possibly, at different bill rates 
for the same employees doing the work. An attorney may handle contract, litigation, real estate, 
and other matters for a client, and again elements of the relationships may vary. Architects and 
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engineers often break down projects into phases, assigning a portion of the contract amount 
and/or budget to the phase of work. 
 
Add Project records, and as needed, project phases and segments. 
 

3. Determine what time records (e.g. timesheets, daily diaries, time entries in your old time and 
billing application) and expenses (e.g. expense reports) are unbilled. Manually enter or import 
these records into BillQuick. 

 

 Before entering time records, review each employee record in BillQuick to 
make sure the Bill Rate and Cost Rate is correct. Also, if special bill rates (and 
special cost rates) apply to work done by employees on a project, be sure to 
define an appropriate Service Fee Schedule and assign it to related projects 
before entering time records. BillQuick uses these rates to calculate the bill 
amount and cost amount of time records. 

 
To manually enter time records, select Sheet View or Simple Time Card from the Time-Expense 
menu. Each time record for an employee requires a date, project to be charged, activity code, 
and hours. A memo or extended note is optional. 
 

 BillQuick supports Control Hours. To activate the feature, check the 
option on the Sheet View screen. It warns you if the hours entered during a 
session are different from the control hours.  

 
To manually enter expense records into BillQuick, Select Expense Log or Simple Expense Log 
from the Time-Expense menu. Each expense record for an employee requires a date, project to 
be charged, expense code, units, and as needed, cost and markup (when a default is not part of 
the expense code). A memo or extended note is optional. 
 

4. When recording old invoices in BillQuick, you have several options: 
 

 ‘Project’ detailed invoices – previous project invoices sent to clients. You can 
enter only outstanding (unpaid) invoices, or invoices going back as long as you 
want practice management information available. See A below. 

 ‘Client’ detailed invoices – previous invoices sent to a client for all work done 
that is not broken out by project. See B below. 

 Balance forward invoices – summary amount by client for all outstanding 
invoices. See C below. 

 
A. To enter detailed invoices by project. . . 
 

 Select Manual Invoice from the Billing menu. 
 Select the ID of the project to which the invoice applies. 
 In the Description field, enter a brief description or explanation for the services 

billed in your old system and the total for the services from the old invoice. On 
the next line, do the same for expenses and check the Exp box.  

 Verify that Amount Due at the bottom of the screen matches the old invoice.  
 Click the Process button. 
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 Repeat for each detailed project invoice. 
 

B.  To enter detailed invoices by client. . . 
 

 Select Project Information from the Project menu. 
 Click the New button. 
 Enter a unique Project ID that identifies the project record as existing only for 

detailed client invoices. Fill in the required fields and click the Save button. 
 Click the Clone button, select the ID of the project you just defined from the 

drop-down list, check the ‘Clone for Selected Clients’ box, and select the clients 
for whom you want to add detailed client invoices. Click the OK button. Close 
the Project screen. 

 Select Manual Invoice from the Billing menu. 
 Select the ID of the first ‘client invoices’ project.  
 In the Description field, enter a brief description or explanation for the services 

and the total amount for all services from the old invoice. On the next line, do 
the same for expenses and check the Exp box.  

 Verify that the Amount Due at the bottom of the screen matches the old invoice.  
 Click the Process button. 
 Repeat for each detailed client invoice. 

 
C.  To enter balance forward invoices by client. . . 

 
 Select Project Information from the Project menu. 
 Click the New button. 
 Enter a unique Project ID that identifies the project as existing only for balance 

forward amounts. Fill in the other required fields and click the Save button. 
 Click the Clone button, select the ID of the project you just defined from the 

drop-down list, check the ‘Clone for Selected Clients’ box, and select the clients 
for whom you want to add balance forward amounts. Click the OK button. 
Close the Project screen. 

 Select Manual Invoice from the Billing menu. 
 Select the ID of the first ‘balance forward’ project.  
 In the Description field, enter a brief description such as ‘Balance Forward for 

Client ABC’ and the total service amount for all outstanding invoices. On the 
next line, do the same for expenses and check the Exp box.  

 Verify that Amount Due at the bottom of the screen matches the summary 
balance.  

 Click the Process button.  
 Repeat the steps above for each balance forward invoice.  

 
5. If you entered any paid invoices, you need to record the associated payment (cash receipt) to 

bring it to ‘paid’ status in BillQuick. Select Payments from the Billing menu and record cash 
receipts, credit memos, and other items for each invoice. Retainer amounts and amounts on 
account can also be recorded on the Payment screen, either to the client or to a specific project. 
 
If you entered only outstanding invoices or balance forward amounts, you can move to the next 
step. 
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4.  Sync Settings 
 
Now that you have data set up in BillQuick, you need to transfer it to Peachtree Accounting so that both 
applications begin processing from the same point. For BillQuick to know what data to transfer and your 
other integration preferences, you need to define integration settings. Later, you can fine-tune the 
settings for day-to-day integration (see 5. Fine-Tune Synchronization Settings below).  
 

1. Look at the status line at the bottom of the BillQuick screen. It displays the currently open 
BillQuick database. If it is not the one you want to integrate with, select File menu, Open 
Company. Choose the correct company, and then continue to the next step. 

 
2. From the Integration menu, 

select Peachtree 
Accounting, Sync Settings.  

 
 
 
 
 
 
 
 
 
 
3. Click the General tab. Select your Peachtree Version and the desired Peachtree Company file 

from the drop-down list or click Browse to locate it. 
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4. Click the Connect button to establish a link to the Peachtree database. If the Peachtree 
application is not running, it starts automatically.  

 
At the bottom, it displays the location of the BillQuick Database that will integrate with 
Peachtree. 

 
5. If you want to map the Peachtree Cost Codes with the BillQuick Activity/Expense Codes during 

sync, check that option at the bottom. 
 

6. Click the Send Settings tab. In order, select each Module and assign desired settings to it. 
 

 
 

7. You only need to decide whether to send each type of BillQuick data to Peachtree. If you wish to 
restrict what data records transfer to Peachtree, choose one or more filters. See BillQuick 2011 
Help for more information. 

 

 The Get Settings tab is not used because we are sending data from 
BillQuick to populate a new Peachtree database. 

 
8. Click the Accounts tab.  

 
In Peachtree, each item is associated with a general ledger (G/L) account. To ensure activities, 
expenses, invoices and other BillQuick items update the correct G/L account in Peachtree, 
specify their default accounts from the dropdown list. See Peachtree Accounts for more. 
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9. Every payroll item in BillQuick must be assigned a number that will determine the order in which 
it will be listed in Peachtree’s Pay Types list. Select a number for the Default Payroll Item. 
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10. If you want to specify the payroll settings for a specific Employee or Employee Group, select that 
option. Then select a number for different payroll items, say 1 for Regular Time, 2 for Overtime, 
5 for Vacation, etc. This will override the default setting specified above. 

 

 If you assign payroll settings to the Employee Group ‘ALL’, you no longer 
have to go back to Sync Settings screen every time you add a new employee in 
BillQuick. 

 
11. Click Add to associate these BillQuick payroll items to the Peachtree Pay Types and then click 

Save. 
 
4.  Send Data 
 
Now you are ready to synchronize data with Peachtree. 
 

1.  From the Integration menu in BillQuick, select Peachtree Accounting, Send to Peachtree.  
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Repeat this step for the next menu item. Below are the BillQuick Send menu items and the 
corresponding Peachtree screens. 

 

BillQuick  
Send Menu Item 

Peachtree  
Screen 

Activity* Inventory Item 
(Activity) 

Expense Items* Inventory Item 
(Charge) 

Employees* Employee 

Vendors* Vendor 

Clients* Customer 

Projects* Jobs 

Time Entry Time Ticket 

Expense Log Expense Ticket 

Invoices Invoice 

Payments Receipts 

Chart of Accounts Chart of Accounts 

Purchase Orders Purchase Orders 

Vendor Bills Vendor Bills 

* The screen name may be different based on your profession or industry, or if you customized 
them using BillQuick’s Custom Label feature. 

 
6. Fine-Tune Synchronization Settings 
 
After you check the data transferred to Peachtree, you may wish to change your integration settings to 
ones better suited to day-to-day synchronization. See Day-to-Day Integration Settings for more information. 
 
 

Scenario 4: Existing BillQuick-Existing 
Peachtree User 
 
Typically, a company utilizes BillQuick to manage projects, enter time, generate invoices, record 
payments, and produce reports. Peachtree is utilized for accounting tasks such as payroll, accounts 
payable, financial reports and so on. If you have been using both BillQuick and Peachtree, and want the 
two applications to be able to share data, you need to develop a proper integration plan. This plan should 
take into consideration what data (if any) has been transferred between the applications in the past, 
either manually or via Import/Export facility. Based on this, your initial integration steps may vary. 
 
1.  Open Database 
 
Since you have data in both BillQuick and Peachtree, you need to open both applications. Ensure that the 
company databases that you wish to synchronize are open. 
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2.  Backup Data 
 
Next, back up both BillQuick and Peachtree databases. To back up the BillQuick Database, select 
BackUp Database from the Utilities menu. By default, BillQuick stores the backup copy in the same 
folder as the company database (for example, the standard installation folder x:\Program 
Files\BillQuick2011; x = drive letter). If you want the database copy to be saved in another location, 
select Global Settings-Folders screen from the Settings menu and enter a new location. 
 
Select Back Up from the File menu. Click on the Back Up button on the dialog. 
 
3.  Sync Settings 
 
Existing users have the option to send and get data as per their needs and business practice. What data is 
to be transferred depends on how you have been previously keeping your data in both applications. 
Some of the records being transferred between the two may already be present in the other database.  
In this case, the duplicates need to be merged. 
 

1. Open the BillQuick application. 
 

2. Look at the status line at the bottom of the BillQuick screen. It displays the currently open 
BillQuick database. If it is not the one you want to integrate with, select File menu, Open 
Company. Choose the correct company and then continue to the next step. 

 
3. Start Peachtree and open the database that you wish to integrate with BillQuick. 

 
4. From the BillQuick 

Integration menu, select 
Peachtree Accounting, Sync 
Settings. The BillQuick- 
Peachtree Sync Settings 
screen displays.  

 
 
 
 
 
 
 

5. Click the General tab. Select your Peachtree Version. Also, select the desired Peachtree 
Company file from the drop-down list or click Browse to locate it. 
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6. Click the Connect button to establish a link to the Peachtree database. If the Peachtree 
application is not running, it starts automatically.  

 
You can see the location of the BillQuick Database that will integrate with the Peachtree. 

 
7. If you want to map the Peachtree Cost Codes to BillQuick Activity/Expense Codes during sync, 

then check that option at the bottom. 
 

8. Determine what data you want to get from Peachtree and what data to move into Peachtree. 
Accordingly, select the Send Settings or Get Setting tab. You can specify various filters and other 
options for each module selected from the list on the left. 

 



Initial Integration 

 

BillQuickPeachtree Integration Guide 2011.1                                                                                                                     Page 38 

 
 

 You should send approved time entries to Peachtree only if you do payroll 
there. 

 

 If you have created invoices and payments in Peachtree only, you should 
move the clients, projects and employees from BillQuick to Peachtree. Once 
these records are moved, you can then link the Peachtree invoices and 
payments to these projects (jobs). 

 
9. Click the Accounts tab. In Peachtree, each item is associated with a general ledger (G/L) account.    

 
To ensure activities, expenses, invoices and other BillQuick items update the correct G/L account 
in Peachtree, you must specify their default accounts from the dropdown list. See Peachtree 
Accounts for more. 
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10. Every payroll item in BillQuick must be assigned a number that will determine the order in which 
it will be listed in Peachtree’s Pay Types list. Select a number for the Default Payroll Item. 
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11. If you want to specify the payroll settings for a specific Employee or Employee Group, select that 
option. Then select a number for different payroll items, say 1 for Regular Time, 2 for Overtime, 
5 for Vacation, etc. This will override the default setting specified above. 

 

 If you assign payroll settings to the Employee Group ‘ALL’, you no longer 
have to go back to Sync Settings screen every time you add a new employee in 
BillQuick. 

 
12. Click Add to associate these BillQuick payroll items to the Peachtree Pay Types and then click 

Save. 
 
4.  Sync Data 
 
Now you are ready to synchronize data between BillQuick and Peachtree. 
 

 If you are trying to integrate a BillQuick Sample database with Peachtree, 
you will be warned prior to the sync. 

 
1. From the Integration menu, 

Peachtree Accounting in 
BillQuick, select an 
appropriate option - Send to 
Peachtree or Get from 
Peachtree.  

 
 
 
 
 
 
 
2. In turn, select each menu item, starting with Activity/Service Items. After the progress bar 

indicates that the transfer is complete, open the corresponding screens in BillQuick and 
Peachtree and verify whether the data is complete. See Quick-Check for more information. 

 
Repeat this step for the next menu item. Below are the BillQuick Send/Get menu items and the 
corresponding Peachtree screen. 
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BillQuick  
Menu Item 

Peachtree  
Screen 

Activity/Service 
Items* 

Inventory Item 
(Activity) 

Expense/Charge 
Item* 

Inventory Item 
(Charge) 

Employees* Employee 

Vendors* Vendor 

Clients* Customer 

Projects/Jobs* Jobs 

Time Entry Time Ticket 

Expense Log Expense Ticket 

Invoices Invoice 

Payments Receipts 

Chart of Accounts Chart of Accounts 

Purchase Orders Purchase Orders 

Vendor Bills Vendor Bills 

* The screen name may be different based on your profession or industry, or if you customized 
them using BillQuick’s Custom Labels feature. 

 
5.  Match Data  
 
In case of existing BillQuick and Peachtree users, it is likely that duplicate records are found in the other 
application. This duplication arises because of separate entry of data in the two applications, even for 
similar records. The matching of these records can be a time consuming process. However, you will need 
to do it only once and then from that point onwards, data sync can be scheduled accordingly. To save 
time, you can skip matching of inactive records.  
 
During data sync process, BillQuick will either overwrite the duplicate data or leave it as is, depending 
upon the Overwrite Rules specified in the BillQuick-Peachtree Sync Settings screen. 
 
You can manually check and merge the duplicate data in any of the applications. The records that were 
moved from BillQuick to Peachtree should stay and the Peachtree records can be deleted after you have 
copied that data to the records created by BillQuick. The main reason for keeping the BillQuick-created 
records is that BillQuick maintains a link between the two applications after the first sync. This PTLinkID 
helps to update the two records in the future.  
 
Alternatively, you can make use of BillQuick’s Smart Match feature to link similar records or unlink 
different records. With this feature, BillQuick attempts to find matching data (both active as well as 
inactive) and link them automatically. If it fails to find a match, you can match it manually.  
 
You can view both BillQuick and Peachtree data on the BillQuickPeachtree Smart Match screen.  
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Depending upon the option selected in the Data field in the button panel, the data records will be 
displayed in grids, separately for BillQuick and Peachtree. E.g., if you select Activity Codes in the Data 
field, you can view activity data already matched between the two applications on the Matched tab.  
 
The grid will display BillQuick records and corresponding matched Peachtree records. If needed, you can 
select the matched records and then un-match them using the UnLink button. Similarly, on the 
Unmatched tab, you will see unmatched data between the two applications. If needed, you can select the 
unmatched records and then match them using the Link button. 
 
6.  Fine-Tune Synchronization Settings 
 
Data touchup is needed in BillQuick after getting data from Peachtree because BillQuick requires certain 
fields which might be optional in Peachtree.  
 
After you check the data transferred to/from Peachtree, you may wish to change your integration settings 
to ones better suited to day-to-day synchronization. See Day-to-Day Integration Settings. 
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Quick Check 

 
 
A standard procedure after initial synchronization of data between BillQuick and Peachtree Accounting is 
to check data. This ensures transferred data is accurate and complete. 
 

 BillQuick contains multiple processes to ensure accurate and complete 
transfer of data. However, you may find that a setting in Peachtree may have 
restricted transfer of data. Or you may have inadvertently checked a filter on 
the Sync Settings screen. Checking data before you begin normal processing 
ensures no surprises later.  

 
After synchronizing, go to the section below for the type of data and follow the suggested instructions.  
 
1.  Check Activity and Expense Codes   
 
Detailed Checking 
 

1. In Peachtree, select Inventory Items from the Maintain 
menu. 

2. In BillQuick, select Activity Codes from the View menu. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Switch between the applications, selecting the same 
activity item in both and checking that the data is same.  

4. Repeat this for Expense Codes. In BillQuick, select Expense Codes from the View menu. 
Compare the records to Inventory Charge Items in Peachtree.  
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Summary Checking 
 

1. In Peachtree, select Reports & Forms menu, Report Groups. From the ‘Select a Report 
or Form’ screen, select Inventory on the left. Select and double-click Item List to display 
that report (if desired, you can print the report).  

 

 
 

2. In BillQuick, select Activity Master 
File report from the Activity Codes 
screen. Else open it from the Reports 
menu, Activity.  

3. Compare the two lists to ensure all 
the activities are transferred. 

4. Repeat steps 2 and 3 for Expense 
Codes. 
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2.  Check Employees  
 
Repeat the above process for employee data. Use the Detailed Checking or Summary Checking method. 
 
For detailed checking, in Peachtree select Maintain menu, Employees/Sales Reps. In BillQuick, select 
View menu, Employees. Compare the employee list in both screens. 
 
For summary checking, in Peachtree select Reports & Forms menu, Report Groups, Payroll; then double-
click Employee List. In BillQuick, select Reports menu, Employee and open the Employee Master File 
report. Compare the data in the two reports. 
 

 Before entering time records, or transferring time records from Peachtree, 
review each employee record in BillQuick to make sure the Bill Rate and Cost 
Rate are correct. Also, if special bill rates (and special cost rates) apply to work 
done by employees on a project, be sure to define an appropriate Service Fee 
Schedule and assign it to related projects before entering or transferring time 
records. BillQuick uses these rates to calculate the bill amount and cost amount 
of time records. 

 
3.  Check Vendors 
 
Repeat the above process for vendor data. Use the Detailed Checking or Summary Checking method. 
 
For detailed checking, in Peachtree select Maintain menu, Vendors. In BillQuick, select View menu, 
Vendors. Compare the vendor list in both screens. 
 
For summary checking, in Peachtree select Reports & Forms menu, Report Groups, Accounts Payable; 
then double-click Vendor List. In BillQuick, select Reports menu, Report Center and open the Vendor 
List report. Compare the data in the two reports. 
 
On the BillQuick Vendor screen, determine which of the vendors transferred from Peachtree (if any) 
should be deleted. Select the vendor from the grid, verify you selected the correct vendor and click the 
Delete button. 
 

 If you enter time records for vendors (subcontractor or consultants) in 
BillQuick, be sure to change the Bill and Cost Rates. When transferred from 
Peachtree, BillQuick inserts $0 as placeholder values in vendor records.  

 
4.  Check Clients/Customers 
 
Repeat the above process. Use the Detailed Checking or Summary Checking method. 
 
For detailed checking, in Peachtree select Maintain menu, Customers/Prospects. In BillQuick, select View 
menu, Client. Compare the client list in both screens. 
 
For summary checking, in Peachtree select Reports & Forms menu, Report Groups, Accounts 
Receivables; then double-click Customer Master File List. In BillQuick, select Reports menu, Client and 
open the Client Master File report. Compare the data in the two reports. 
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5.  Check Projects/Jobs 
 
Repeat the above process. Use the Detailed Checking or Summary Checking method. 
 
For detailed checking, in Peachtree select Maintain menu, Job Costs, Jobs. In BillQuick, select Project 
menu, Project Information. Compare the project list in both screens. 
 
For summary checking, in Peachtree select Reports & Forms menu, Report Groups, Job Reports; then 
double-click Job Master File List. In BillQuick, select Reports menu, Project and open the Project Master 
File report. Compare the data in the two reports. 
 

Special Note 

BillQuick is project-centric. Each project is associated with a client. Time and 
expenses are charged to a project, and bills are generated by project (though 
multiple bills can appear on a joint invoice).  
 
In Peachtree you may have billed customers rather than jobs (projects). If so, no 
projects appear in BillQuick because there are no jobs to transfer. Similarly, if 
you billed some jobs and some customers, only the existing jobs transfer to 
BillQuick.  
 
However, BillQuick automatically creates projects on-the-fly when you transfer 
customer invoices from Peachtree. The Project ID is based on the Client ID. 
Also, because Project Manager is a required field in BillQuick, and there is no 
corresponding field in Peachtree, BillQuick creates a new employee record with 
placeholder values, ‘FromPeachtree’. This maintains data integrity in BillQuick. 
You can decide who is responsible for each project/job later. 
 
Bottom Line: You may need to repeat this quick-check step after synchronizing 
Peachtree invoices to BillQuick. 

 
6.  Check Time Entries 
 
Repeat the above process for time entries. Use the Detailed Checking or Summary Checking method. 
 
For detailed checking, in Peachtree select Lists menu, Time/Expense, Time Tickets. In BillQuick, select 
Time-Expense menu, Enter Time, Sheet View. Compare the time entries in both screens. 
 
For summary checking, in Peachtree select Reports & Forms menu, Report Groups Time/Expense 
Reports; then double-click Payroll Time Sheet. In BillQuick, select a time entry report from the Reports 
menu or Report Center. Compare the data in the two reports. 
 
7.  Check Expense Entries 
 
Repeat the above process. Use the Detailed Checking or Summary Checking method. 
 
For detailed checking, in Peachtree select Lists menu, Time/Expense, Expense Tickets. In BillQuick, 
select Time-Expense menu, Enter Expense, Expense Log. Compare the expense entries in both screens. 
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For summary checking, in Peachtree select Reports & Forms menu, Report Groups, Time/Expense 
Reports; then double-click Expense Ticket Register. In BillQuick, select an expense entry report from the 
Reports menu or Report Center. Compare the data in the two reports. 
 
8.  Check Invoices 
 
Repeat the above process for invoices. Use the Detailed Checking or Summary Checking method. 
 
For detailed checking, in Peachtree select Lists menu, Customers & Sales, Sales Invoices. In BillQuick, 
select Billing menu, Review Invoices, Invoice Review. Compare the invoices in both screens. 
 
For summary checking, in Peachtree select Reports & Forms menu, Report Groups, Accounts 
Receivable; then double-click Invoice Register. In BillQuick, select Reports menu, Billing and open the 
Invoice Register. Compare the data in the two reports. 
 
9.  Check Payments 
 
Repeat the above process for payments. Use the Detailed Checking or Summary Checking method. 
 
For detailed checking, in Peachtree select Lists menu, Customers & Sales, Receipts. In BillQuick, select 
Billing menu, Receive Payments, Payments. Compare the payments in both screens. 
 
For summary checking, in Peachtree select Reports & Forms menu, Report Groups, Accounts 
Receivable; then double-click Cash Receipts Journal. In BillQuick, select Reports menu, Payments and 
open the Cash Receipts Journal report. Compare the data in the two reports. 
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Day-to-Day  
Integration Settings 

 
 
After completing initial synchronization, review current settings to determine if they should be fine-tuned 
for day-to-day processes.  
 
It is a good practice to maintain clients, projects, time and expenses, billing, accounts receivables, 
payments and reports in BillQuick. Peachtree should be used for functions such as accounts payable, 
general ledger, banking, payroll and financial statements. The following illustration gives an idea about the 
common breakdown of tasks you should be doing in BillQuick and Peachtree. 
 

 
 
Below are situations to consider for each type of data and also the best practices followed in the industry. 
 

 Please check the Integration Rules for underlying rules and details about 
BillQuick Peachtree Integration. 

 
 

Master Information 
 
Consider where you want to save each type of master information – activity codes, expense codes, 
employees, clients, and projects. When you add, edit or delete records, do you want this task done in 
BillQuick, in Peachtree, or both? 
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Commonly, companies maintain project records in BillQuick only. This is the core information essential 
to effective practice management and maintaining it in BillQuick is appropriate. Hence, it is better to 
create and maintain that data in BillQuick and send it to Peachtree. 
 
However, it is a good practice to create activity and expense (other charge) items in Peachtree because 
appropriate G/L accounts are assigned to them there. It is easier to transfer these items into BillQuick 
along with their G/L accounts. To enforce this policy, you should accordingly ‘turn on’ getting this data 
from Peachtree. This can be done in the BillQuick Peachtree Sync Settings screen by selecting the 
desired module and un-checking the ‘Do Not Get’ option. 
 
Where you maintain client (customer) records depends on your situation.  
 

Situation Sync Setting Action 

Require extensive customer 
information (e.g. sales and 
payment defaults) 

From Send Settings list, 
select Client and check the 
‘Do Not Send’ box. 

Maintain customer records 
in Peachtree. Get updated 
records from Peachtree as 
needed. 

Require typical customer 
information  

From the Get Settings list, 
select Client and check the 
‘Do Not Get’ box 

Maintain client records in 
BillQuick. Send updated 
records to Peachtree as 
needed. 

Desire convenience of 
update data common to 
BillQuick and Peachtree, or 
want to enter data in either 
system 

From the Send Settings and 
Get Settings list, select 
Client and make sure both 
‘Do Not…’ boxes are 
unchecked. 

Synchronize as needed. 

 
Decisions about employees follow a similar process.  
 
 

Time Records 
 
You can record all time entries in BillQuick or one of its add-on modules and then send it to Peachtree 
via integration. Whether you transfer time records from Peachtree or not, time entries from employees 
(and vendors/consultants) should be entered in BillQuick. It is designed for maximum data entry efficiency 
and maximum flexibility (4 built-in ways to manage time, plus 5 ways to capture your hours remotely). 
BillQuick also includes numerous time and expense/work-in-progress reports. 
 
If you do payroll through Peachtree, you would send time records to Peachtree. Make sure the ‘Do Not 
Send’ box for Time Entry is unchecked for Send Settings option in BillQuick-Peachtree Sync Settings 
screen. BillQuick Time Entries become Peachtree Time Entries. 
 
If payroll is not done through Peachtree, then there is no reason to send time entries to it. Check the ‘Do 
Not Send’ option for time entries.  
 

 For payroll done using other applications, you can export time entries using 
BillQuick’s Import/Export feature (Utilities menu).  
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When you integrate with Peachtree, a flag can be associated with a payroll item. For example, if you track 
hours as well as piecework in BillQuick and pass both types of hours to Peachtree, the hourly work might 
be associated with the regular pay item and piece work with another payroll item. Whether time entries 
flow to Peachtree, depends on your situation. 
 

Situation Actions 

Use hours to 
process payroll 

Transfer time entries to Peachtree. Block time entries 
flowing from Peachtree into BillQuick.  

Do not use hours 
to process 
payroll 

Do not transfer time entries to Peachtree. Block time entries 
flowing from Peachtree into BillQuick. 

Use hours for 
special analysis 

Determine whether you analyze time (a) as a custom 
BillQuick report, (b) when exported to Excel, or (c) through 
Peachtree. If (c) then follow the first suggestion above. 

 
However, there are some integration rules that limit the re-sending of the same time data to Peachtree. 
For example, if you send a time entry to Peachtree (say for 40 hours) and then change it in BillQuick, it 
cannot be re-sent as it creates duplicate hours. Even if you delete it in Peachtree, it cannot be re-sent 
from BillQuick because it has already established a Link ID for it.  
 
 

Expense Records 
 
You can record expenses in BillQuick or Peachtree. There is no duplication of data involved in the 
integration process between BillQuick and Peachtree. However, Peachtree does not accept negative 
expenses. To transfer expenses to/from BillQuick, make sure the Do Not Get/Send box for Expenses is 
used accordingly.  
 

 If you send invoices with negative line items from BillQuick, the total of all 
line items has to be positive for data transfer to Peachtree. 

 
Whether you process reimbursable expenses to employees (e.g., travel, mileage) and other items 
chargeable to project (e.g., vendor invoices, materials) in BillQuick or in Peachtree depends on the 
accounting software you use and your company procedures. 
 

Situation       Actions 

Record 
employee and 
vendor 
expenses in 
BillQuick 

1. Enter expenses in Expense Log. Mark the ‘R’ box. 
2. Review and approve expenses. Adjust markups and charge 

amounts as needed.  
3. Synchronize the expenses with Peachtree from the Integration 

menu.  
4. Cut checks for employee and vendor reimbursements when 

ready. 

Record 
expenses in 
BillQuick and 
reimbursable 

1. Enter copies, faxes and other resource usage expenses in 
BillQuick.  

2. Record reimbursable expenses for employees and vendors in 
Peachtree (e.g., from expense reports, download credit card 
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expenses in 
Peachtree 

statements) and assign to jobs.  
3. Synchronize BillQuick and Peachtree expenses using the 

Integration menu.  
4. Cut checks for employee and vendor reimbursements when 

ready. 

Record 
expenses in 
Peachtree 

1. Enter expenses in Peachtree.  
2. Synchronize them with BillQuick using the Integration menu.  
3. Review and approve expenses on Expense Log, adjusting 

markups and charge amounts as needed.  
4. Cut checks for employee and vendor reimbursements when 

ready. 

 
Although you can send both Expense Log entries and vendor bills from BillQuick to Peachtree, but 
Peachtree accepts them only as vendor bills. When you are sending employee expenses to Peachtree as 
bills, BillQuick prompts you to predefine the Employee ID to Vendor ID switch. You can choose whether 
it is for all expenses or not, and specify the switch for different expenses. BillQuick can remember those 
settings and accordingly change the Employee ID to Vendor ID during the current sync and in future.  
 
BillQuick vendor bills have a unique Bill No. (maximum length = 50 characters) and Reference No. 
(maximum length = 60 characters) while Peachtree has an Invoice No. (maximum length = 20 
characters) only. BillQuick maps its Bill No. to Peachtree’s Invoice No.   
 
Typically, you may enter the vendor's invoice number in BillQuick's Bill No. field. To avoid duplicate bill 
numbers, you can append it with a date or ID. E.g., if you received a bill from a vendor named ABC on 
May 25, 2011 with invoice number 2000, you can enter it as 2000-052510. Some of you may prefer to 
prefix it with the Vendor ID. Then it would be ABC-2000. 
 
 

Invoice Records 
 
Creating invoices in BillQuick is the best course of action because it provides details critical to effective 
practice management. The most common synchronization setting for invoices is to send invoices from 
BillQuick to Peachtree (‘Do Not Send box’ is unchecked and the ‘Do Not Get box’ is checked in the 
BillQuick-Peachtree Sync Settings screen).  
 
There can be an exception to this situation. For example, if you generate product invoices in Peachtree 
and you want to record payments for all invoices, then you would not turn off getting invoices from 
Peachtree.  
 
Generally, invoices with zero value ($0) do not transfer from BillQuick to Peachtree. You may generate 
zero dollar invoices in BillQuick in various ways: 
 

 You may manually adjust the New Bill value to $0 in the Billing Review screen. 
 You may generate a write-down on the invoice to $0 in the Time Entry or Billing Review 

screen. 
 You may generate a manual invoice with a $0 value in the Manual Invoice screen. 
 You may apply a huge discount to the bill amount, bringing down the Net Bill to $0 in the 

Manual Invoice or Billing Review screen. 
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 You may apply a retainer to the invoice, totally the Net Bill to $0 in the Manual Invoice or 
Billing Review screen. 

 
The only exception to transferring a zero dollar invoice is in case of discounts and retainers. You can send 
such invoices to Peachtree in spite of having a $0 bill value. 
 
 

Late Fee Invoices 
 
At times, you may include a late fee or finance charge on your invoices. In such cases, you will receive a 
payment for the invoice amount plus that late fee amount. Earlier BillQuick transferred the invoice 
amount to Peachtree but did not transfer the late fee or its payment. In order for the accounts receivable 
to match in the two databases (reconciliation of transactions), you had to manually create a finance 
charge and corresponding payment in Peachtree. The finance charge had to be for the exact amount of 
late fees. 
 
However, BillQuick allows you to transfer late fee charge to Peachtree just as standard invoices. When 
you create a separate late fee invoice in Invoice Review screen, BillQuick generates a manual invoice 
internally with an invoice number same as that of the actual invoice but with ‘LF’ appended to it. The first 
late fee invoice will have the same invoice number but with a prefix of LF, and any subsequent late fee 
invoices will have initials LF1, LF2 and so on. Once created, you can transfer this manual late fee invoice 
to Peachtree. You can also create a separate late fee payment for this invoice (excluding the principal 
amount) and then transfer it to Peachtree. While transferring late fee invoices and payments, BillQuick 
will post them to the appropriate Peachtree accounts.  
 

 You can specify invoice accounts in the BillQuick-Peachtree Sync Settings 
screen.  

 
 

Payments 
 
You may decide to record payments for invoices and retainers in either BillQuick or Peachtree. Or you 
may choose the convenience of entering payments in BillQuick. Mark the ‘Do Not Send’ and ‘Do Not 
Get’ options according to your preference. 
 

 In any case, you should make use of Date Filters in the Sync Settings screen 
to place less burden on the BillQuick and Peachtree databases with unnecessary 
data transfer. 
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Best Practices 
 

Items BillQuick Peachtree 

Employees   

Vendors   

Activity/Service items   

Expense/Charge Items   

Clients   

Projects/Jobs   

Estimates/Budgets   

Service Fee Schedules   

Chart of Accounts   

Time   

Expenses   

Billing   

Vendor Bills   

Accounts Payable   

Accounts Receivable   

Invoices   

Payments   

Payroll   

Reports   

Financial Statements   

Banking   

 
 

 
 
Congratulations! You have now an understanding of data integration between BillQuick and Peachtree, 
how to ensure that the data transfer is accurate and how to verify which records have integrated. To 
learn more, check the BillQuick Help. 
 
For more information, visit us at www.bqe.com.If you have any trouble in using our integration utility, 
please contact BillQuick Support at (310) 602-4030 or Support@bqe.com. For other questions, please 
call us at (888) 245-5669 (US and Canada) or (310) 602-4020; or email Sales@bqe.com. 
 

 

 

http://www.bqe.com/
mailto:Support@bqe.com
mailto:Sales@bqe.com
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